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Introduction 
 
The decisions made during release planning do not always turn out to be the most appropriate 
after the release have been on the market for some time. By understanding the inappropriate 
decisions and why they were made it is possible to identify potential improvements to the 
release planning process. Retrospective analysis [Kerth] is done to gain understanding about 
the inappropriate decisions. 
 Rainbowie Parseq is a tool designed to support the retrospective analysis technique 
known as PARSEQ [Parseq]. Rainbowie Parseq has many similarities to other requirements 
engineering tools, but its purpose is not to store and manage large amounts of requirements. 
 
 

Installation 
 
You should have gotten a zip-file that you unzip into any folder of your choice. Make sure 
that the directory structure is kept intact, see Figure 1, or you might get trouble with reading 
and writing Excel-files or reading images and help-files. 

 
Figure 1The Rainbowie install directory should  
look like this. 

 

System Requirements 
You must have a Java Runtime Environment (JRE) installed on your computer’s system path. 
 We recommend Java versions J2SE 1.4.2 due to lack of testing, but Rainbowie Parseq 
should run without problems under both older and newer versions. 
 You can download Java at http://java.sun.com. 
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Using Rainbowie Parseq 
 
Start Rainbowie Parseq by, 
 

• In Windows or similar: double-clicking the Rainbowie icon in the folder that 
Rainbowie was installed 

• In Unix, Dos or similar: typing java -jar Rainbowie.jar in the directory that 
Rainbowie was installed 

 

Rainbowie Parseq is now running and the main window, shown in Figure 2, is displayed. 
 

 
Figure 2 The main window of Rainbowie Parseq. 

 
It is from this window that you choose when to import, reprioritize and do a root-cause 
analysis of the requirements, given that the previous step has been completed. 
 Feed-back about how far you have come in the process is given by buttons that are 
enabled and the tables that are filled once the appropriate step has been completed. 
 
The menu bar 
The menu bar is present in almost every window; there you can get help on how to use the 
program at any given time. Most of the functionality available through the buttons is also 
available through the menu. Therefore, you will in this guide, only find information about the 
menu when it contains functionality that is not covered by the buttons. 
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Importing requirements 
 

 
Figure 3 The Import Window where the requirements to process are entered. 

 
There are two ways to enter requirements into the program; both are done through the Import 
Window, see Figure 3, that you open by pressing the Import button in the main window. 
Either you enter the requirements you want manually or you import the requirements from an 
Excel sheet. If you wish to reset and clear the table, go to the Edit-menu and choose Clear 
table. 
 Only the requirements’ numbers are necessary, the numbers must be unique and there 
must be at least two requirements before you can continue.  
 When the table contains all the requirements you want to import, you press the Accept 
button. This will return you to the main window, where the left table now contains the 
imported requirements. 
 
Enter requirements manually 
By double-clicking the row in the table where you want the requirement to be entered will let 
you enter a requirement manually. You can also edit a row by selecting it and pressing the 
Edit Row-button or by pressing the Enter-key. This will open the Edit Window, shown in 
Figure 4, where you enter the information you want. Then, you press the Accept-button in the 
Edit Window and the information you entered will be added to the table in the Import 
Window. 
Only the last, Release #, column can be edited directly in the Import Window. This is to 
prevent users from changing a requirement by mistake. 
 
 

 

Figure 4 The Edit Window where requirements can be edited or entered. 
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Import requirements from Excel 
The Excel-sheet you want to import from must be formatted in the correct way. That is, the 
requirements’ numbers, descriptions and release numbers must each be in their own column 
and there must only be one requirement on each row. It is, however, only necessary to have 
and import the requirements’ numbers. The requirements’ descriptions and release numbers 
are optional. 
 To import from an Excel-sheet, press the Open-button in Import Window. This will 
open a file chooser dialog, where you select the Excel-file to open. The opened Excel-file will 
be read into the Excel importer window, Figure 5Figure 2, this is a read-only window that will 
not and cannot edit the Excel-file. 
 

 
Figure 5 Excel importer window. 

 
In the Excel importer window, follow these steps: 
 

1. Select the sheet with the requirements you want to import 

2. Double-click the cell containing the first requirement to import 

3. Double-click the cell containing the last requirement to import. This will select all the 
requirements between the first and last requirement. 

4. Double-click anywhere in the column containing the requirements’ descriptions to 
select them. 

5. Double-click anywhere in the column containing the requirements’ release numbers to 
select them. 

6. Press the Accept button 
 
Step 4 and 5 are optional. You can skip step 4 by pressing the Skip button. You do not have to 
press the Skip button if you want to skip step 5 or both step 4 and 5, pressing Accept will 
automatically skip the remaining steps and close the window. 
 By pressing the Accept-button, you are returned to the Import Window. 
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Reprioritizing requirements 
When you have imported the requirements, it is time to reprioritize them. Pressing the 
Reprioritize button in the main window will open a dialog, Figure 6, where you choose the 
appropriate method and criteria to prioritize by. 
 There are three predefined, commonly used, criteria: Value, Cost and Risk. There is also 
two text fields if you wish to define your own criteria. 
 

 
Figure 6 The window where prioritizing method and criteria are selected. 
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Planning Game 
In the Planning Game the cards on the desk are sorted into the three boxes, where each box 
corresponds to a level of importance to the criteria. Within each box the cards are sorted 
where the card most relevant to the criteria is put on the top. 
 

 
Figure 7 The Planning Game window. 

 
First choose which criteria to start prioritizing after by using the combobox in the upper right 
corner. This can only be done before the first card has been put in a box. 
 Then, for each card, click & drag it to one of the boxes. When a box is highlighted you 
can drop the card in that box. More than one card can be selected by dragging a selection 
square or by holding down the Ctrl-key while clicking on the cards you want to select. The 
selected cards can then be moved and dropped in a box together. Dragging and dropping 
multiple cards do not guarantee the order the cards will have in the box. 
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To sort the cards in a box, open it by double-clicking on that 
box, then click & drag the cards. If you notice that a card is in 
the wrong box, you can highlight that card and press the Send 
to desk button, the card sent to the desk can now be put in 
another box. This is the only way to move the cards between 
the boxes or between a box and the desk. 
 When you are finished with the prioritization for the 
first criteria, press the Next Criteria-button and a window will 
appear with an overview of the prioritization. In this window 
you can choose to confirm or reject the prioritization, you can 
also choose to assign relative values to the requirements. 
 If you press Assign values, a window for assigning 
relative values using a modified 100-technique will be 
shown. If you choose to assign, or not to assign, values for 
the first criteria, you must do the same for the last criteria as 
well. The same procedure is then used when you are finished 
with the prioritization for the last criteria. 
 
 

Figure 8 Window representing a 
box 
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Pair-Wise Comparisons 
In the Pair-wise Comparisons technique the priorities are decided by comparing the 
requirements two and two. To get the correct result, all possible pairs should be compared. 
However, this means that in practice there can be a huge number of needed comparisons. 
Therefore, approximate priorities can be calculated using an incomplete pair-wise 
comparisons technique, this is what is done in this program if you choose to stop before all 
possible pairs have been compared. Although, you are encouraged to keep in mind that this 
may result in some errors in the prioritization. 
 

 
When the window is open, the 
current comparison is shown in 
the text fields and their relative 
importance to each other is set 
using the radio buttons below. 
 First choose which 
criteria to start prioritizing after 
by using the combobox in the 
upper right corner. This can 
only be done before the first 
comparison have been done. 
 
To set the relative significance, 
either double-click a radio 
button or select a radio button 
and press the Next-button. This 
will bring up the next pair to 
compare. The more significant 
one requirement is, than the 
other, a radio button further to 

that side should be selected. If you hold the mouse over a radio button, an explanation will be 
shown. 
 You can go back to look at and change previously compared pairs by pressing the Back-
button. 
 Through the progress bar at the bottom of the window and the information to the right in 
the window, you can follow your progress and see how many pairs you have left, throughout 
the prioritization. 
 You must complete at least the same number of comparisons as the amount of 
requirements to be able to get any result at all. 
 Under the Options-menu, whether or not you want to show radio buttons for 
intermediate values. These intermediate values are used when a compromise between two 
adjacent judgments must be done. 
 Another feature that is found under the Options-menu is the possibility to set the number 
of paths in the graph to use when calculating priorities with the incomplete pair-wise 
comparisons (IPC) algorithm [Harker]. If you are unfamiliar with the IPC algorithm it is 
recommended that you do not change these values. 
 
 

Figure 9 The Pair-Wise Comparisons window. 
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$100 Technique 
In the $100 technique the priorities are decided by giving each requirement a share of a total 
budget of 100 dollars. This means in practice that each requirement is given a percentual rate 
of significance according to the currently used criteria. 
 If a large number of requirements are being prioritized, the $100 limit can be extended 
to $1000 to make it easier to divide the money. 
 If this window is opened after an initial prioritization with the Planning Game 
technique, i.e. it was chosen to assign relative values from the Planning Game’s Confirm 
window; the order of the requirements in the table must be sustained when assigning 
priorities. This means that you cannot assign a higher value to a requirement positioned in a 
lower row. 
 

 
Figure 10 The $100 Technique window. 

 
First choose the prioritization criteria to start with by using the combobox in the upper right 
corner of the window. This combobox will be disabled when the first value has been assigned 
to a requirement. 
Then choose if $100 or $1000 shall be used as a limit for the prioritization. This parameter 
can be changed anytime until the Next Criteria-button is pressed for the first time. 
 
You then prioritize by assigning values to the requirements by clicking the $-field and 
entering the desired amount for each requirement. If you leave a requirement unassigned, it 
will receive $0. 
 When all $100/$1000 has been assigned for the first criteria, press Next Criteria to 
prioritize after the last criteria.  
 When the prioritization is done after an initial Planning Game prioritization, the Done-
button must be pressed instead to return to the Planning Game window. 
 When both criteria have been completed, you can choose to finish the prioritization or 
let another user repeat the prioritization. When the latter is done, the average value for each 
requirement will be calculated and used as the priority. 
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Root-cause analysis 
The root-cause analysis is the phase of the process where requirements in need of further 
analysis are identified. When the identification is done, a Root-cause analysis and an 
elicitation of improvement suggestions are done. The support provided by the tool for this 
part is divided into two windows, the Graph window and the Root-cause matrix. 

The Graph window 
In this window, the results from the reprioritization are displayed in a graph. 
 Each requirement's position is shown with an icon. This icon can either be a "+" or one 
or more circles, to tell releases apart. The requirements marked with a "+" have no release 
number assigned. The number of circles are decided in alphabetical/numerical order, for 
instance if we have releases 1, 2 and 3 they would have one, two and three circles 
respectively. 
 

 
Figure 11 An example of the graph after the planning game method. 

The Graph window has a number of functionalities. You can: 
 

• Show the full requirement description by selecting the requirement to show the 
information about it in the text field in the upper right corner of the window. Another 
way to see the full requirement description is to hold the mouse pointer over the 
requirement to see the description as a tooltip. 

• Select a requirement by clicking on the icon in the graph. 

• Add a requirement to the Root-cause matrix, either by double-clicking on the graph 
icon or by first selecting the requirements and then pressing the Analyze 
button/selecting the Analyze menu item. 
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• Visualize dependencies between requirements in the graph by holding down the shift 
key and pressing a mouse button and dragging a line between two requirements. 
When the mouse button is released over the second requirement a dialog will be 
shown where you can enter a description for the dependency. The description area can 
be left empty if not description is wanted. 

• Save the graph as a png-file by pressing the Save Graph-button. 

• Invert the axes of the graph axes by pressing the Invert Graph-button. 

• Choose to hide the dependencies and the text for dependencies and requirements by 
selecting the hide options from the Edit menu. 

• Open the Root-cause matrix window if it is minimized or closed by pressing the Show 
Matrix-button. 

• Switch between two different modes of showing the support lines by choosing Change 
view in the Edit menu. Either fixed values can be used to draw the support lines or 
values relative based on the requirements' positions in the graph. 

•  
There are two main types of Graph windows as shown in Figure 11 and Figure 12. 
 The graph with the boxes as support lines in Figure 11 is shown when the planning 
game was used for prioritization, where each box in the graph represents a box-combination 
from the planning game. By default the support lines are drawn as equally sized boxes. But by 
switching viewing mode the boxes’ size will be adjusted to the number of requirements in 
them. 
 The other prioritization methods will result in a graph like the one in Figure 12. There 
are two support lines in this graph, that by default have the equations 2x and x/2. By switching 
viewing mode the lines will try to be drawn with an equal number of requirements at each 
side. 

 
Figure 12 An example of the graph after the pair-wise comparisons method. 
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The Root-cause matrix 
This is the window where you can define root-causes and improvement suggestions for the 
analyzed requirements. Root-causes and improvement suggestions are entered in the left part 
of the table. In the right part of the table each requirement added from the graph window is 
represented by a column. The results of this analysis can then be exported to an Excel 
spreadsheet. 
 

 
Figure 13 The root-cause matrix. 

 
You link each requirement to one or more root-causes/improvement suggestions by double-
clicking the cell on the same row as the root-causes/improvement suggestions you want to 
link it with. (Double-click again to unlink) 
 To remove a requirement from the root-cause matrix, click on the column header to 
select and highlight that column, and then press the Remove-button. 
 If you need more rows, pressing the Add row-button will add an additional row at the 
bottom of the table. 
 
 
Exporting and saving results 
From the root-cause matrix you can export the results to an Excel-file by pressing the Export-
button. This will open a save-file dialog where you can choose where to save the Excel-file. If 
you choose to save it to an already existing file, that file will be overwritten. All the columns 
are always exported but only the rows that have been marked by checking the checkbox in the 
Print column. 
 You will also be prompted if you want to include the graph in the Excel-file or not. If 
you choose to include the graph it will be exported to the second sheet while the matrix 
always is imported to the first sheet.  
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